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Licensing FmPro Migrator

As of FmPro Migrator v11, all FmPro Migrator downloads are fully functional with features 
unlocked via a single license key.
This section of the manual shows how to enter the license key to unlock the features within 
FmPro Migrator.

FmPro Migrator 11.01
4/14/2024

Demo Edition Dialog

When launched the first time, FmPro Migrator will be running in Demo mode as shown in this 
screenshot. Clicking the Ok button opens the order page of the website.
In addition to transferring data for 5 database fields, the conversion features shown on the GUI 
tab of the Migration Process window will convert 5 layouts or forms/reports & scripts.
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Demo Mode - About Tab

Clicking the "License" button on the About tab, or selecting the Help -> License/About menu items 
will open the About window where you can enter the license key.
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About/License Window

On the About FmPro Migrator window:
(1) Product name and version licensed, (2) Demo or Licensed will be displayed, (3) The Upgrade 
button opens the website order page, (4) Email address associated with your license key, (5) 
Clipboard button reads the license key from the clipboard, (6) License key field, (7) Email Support 
button opens the Contact form on the website, (8) Visit Website opens the order page in Demo 
mode or the product page in Licensed mode, (9) Check for Update opens the downloads page 
with the latest software version, (10) Ok button closes the About window.
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Pasting License Key

Your product license key will be displayed in your web browser when your order has been 
completed. It will also will be sent via email at the same time, please check your SPAM folder if 
the email doesn't arrive in a few minutes.

(1) Copy the license key to the clipboard and click the clipboard icon. Once validated (2) the 
product name will change, (3) the License validation date will be updated, (4) your email address 
will be displayed, and (5) the license key will be displayed in the field under the Email address 
when clicking inside the field. In this screenshot the license key has been obscured.

And that is all you need to do to license all of the features of FmPro Migrator.
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LiveCode Conversion Procedure

This document explains the process of converting FileMaker Pro®, Microsoft Access and Visual 
FoxPro databases into LiveCode (www.LiveCode.com) stacks with FmPro Migrator Platinum 
Edition. FmPro Migrator Platinum Edition converts each  layout/form/report into a LiveCode card, 
containing all of the fields, portals, text, images and buttons from the original layout. 
FmPro Migrator Platinum Edition generates a functional database application within a few 
seconds, including hundreds of lines of LiveCode code within each card of the generated stack 
file. Individual objects including Tab Panels, radio button groups, checkbox button groups and 
Data Grid objects also include the LiveCode code required for an easy to use database front-end 
application. 

This feature leverages the automated layout and relationship importing features of FmPro 
Migrator Platinum Edition, while using FileMaker Pro Advanced, the LiveCode IDE along with the 
SQL database you choose to use to store the data for your application.

LiveCode stack files generated by FmPro Migrator Platinum Edition incorporate the following 
commonly used database application features:

Display Records - When the stack is opened and a connection is made to the converted SQL 
database, the records associated with the converted Layout/Form are displayed in a form viewing 
mode. The fields, text labels, embedded graphics and images are displayed in the same manner 
as the original database file. Record navigation is implemented using 4 controls:
Next Button, Previous Button, Scrollbar and Record Number field entry. SQL database BLOB 
column fields containing images are automatically displayed.
Related records are automatically displayed within individual fields and portals/subforms are 
converted into LiveCode Data Grids . The related records displayed within Data Grids are 
automatically updated when advancing to another record in the parent table.

Update Records - Clicking into any field provides the user with the ability to update the contents of 
the field. Date fields are configured with a Date Picker control. Custom Value Lists from the 
original database are displayed as drop down menus, pop-up menus, radio button group or 
checkbox group depending upon the original field definition.
Related records displayed within Data Grids can be updated just as easily as records in the main 
form.

Insert Records - Individual records can be inserted as a new record in either Browse or Find 
operating modes. Clicking the Insert Portal Row button to the top right of any Data Grid object will 
add a new record to the related database table. As with the original database implementation, the 
primary key for the parent table will be automatically inserted into the foreign key column of the 
related record.

Delete Records - Individual records can be deleted in either Browse or Find modes. If a Delete 

http://www.LiveCode.com
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Row button or image object was embedded in the original FileMaker Portal, then this same 
functionality will also be implemented to delete the selected Data Grid row.

Query Records - Query by example record searching is automatically implemented for each card 
in the stack file. Once a set of records has been found as a result of the query, the navigation 
buttons can be used to navigate thru the found set of records. Individual records can be inserted 
or deleted in found set mode as well as within the standard Browse mode.

This document includes information for the built-in library sub stacks:
fmFunctions_Library - This library duplicates the functionality of 129 of the most commonly used 
FileMaker built-in functions. A tool is provided to remap the original FileMaker functions to these 
LiveCode versions within the converted FileMaker scripts.

Globals_Library - The gGlobals array within the _gGlobalsInitialize handler includes FM 
tables/fields which are used as global variables . These globals are initialized during app startup 
and can be updated anytime by the application, just like FileMaker globals.

Images_Library - This library provides a place where commonly used images can be centrally 
stored within the new application stack. 

SQL_Library - The SQL_Library provides database independent code to connect to your SQL 
database, insert, query, update, delete records, and load relationships from a JSON file.

Stored_Calc_Library - Stored field calculations are defined in this library for each table of the 
database from the original FileMaker database definition. Code which is too complex for 
automatic conversion is commented to prevent errors. This code runs during record update/insert 
database tasks.

Unstored_Calc_Library - Stored field calculations are defined in this library for each table of the 
database from the original FileMaker database definition. Code which is too complex for 
automatic conversion is commented to prevent errors. This code runs as records are read from 
the database by the refreshFields handler on each card. By default, it is commented to improve 
performance, because these calcs do not necessarily need to run for every converted layout. The 
developer needs to decide whether it should run, then enable this code as needed.

Validation_Library - Field validation code during database insert/update tasks is defined for each 
database table inside this library.

Value_List_Library - Custom and field based value lists are defined within this library. Changes 
made here are reflected throughout the entire application. Value lists from Microsoft Access and 
Visual FoxPro are also defined inside this library.

Note: The LiveCode Community icon is displayed in FmPro Migrator for the LiveCode conversion 
feature. This feature is compatible with LiveCode Community and LiveCode Commercial, even 
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feature. This feature is compatible with LiveCode Community and LiveCode Commercial, even 
though the LiveCode Community Edition is no longer being updated. Pricing for the LiveCode 
Commercial versions has been made significantly more affordable. For details, please see the 
LiveCode.com website.

Document Version 12
FmPro Migrator11.01
4/15/2024
[Added new Licensing FmPro Migrator info, updated some of the screenshots.]

Original FileMaker Pro Layout

FmPro Migrator reads the XML definition of a FileMaker layout, and then converts this information 
into a LiveCode card containing all of the fields, portals, text, images and buttons from the original 
layout. An original layout for the sample Asset Management database is shown in the previous 
image.
Note: Microsoft Access and Visual FoxPro projects are also converted into the XML definition of a 
FileMaker layout, when the project metadata is imported into FmPro Migrator.

http://www.LiveCode.com
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Converted LiveCode Card

The resulting LiveCode card is shown in this screenshot. Each field is filled with the name of the 
original Tablename::Fieldname information from the original FileMaker Pro Layout.
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A Status Area background object is provided at the left hand side of the card, to simulate the 
Browse/Find modes from the original database. Menus and scripts are provided in the template 
stack file for hiding/showing the status area and moving the card objects to accommodate the 
Status Area.

Each original layout name is used as the name for the LiveCode card, and when the Layout drop 
down menu is selected, a "go to card" instruction is executed, taking the user to the selected card.

The card objects are placed into a Geometry Manager enabled group named 
"Layout_Objects_Group". As the card is resized, the Layout_Objects_Group is also resized. If the 
window is too small to show all of the objects, scrollbars automatically appear to enable scrolling 
by the user.

Converted FileMaker Script Code

If FileMaker scripts have been copied into FmPro Migrator Platinum Edition via the ClipBoard, then 
these scripts will be converted into LiveCode handlers. The 34 most commonly used (out of 140) 
ScriptMaker steps are converted directly into LiveCode code.  FileMaker script commands such as 
Go to Layout are converted into the LiveCode "go to card" command, the Freeze Window/Refresh 
Window commands are converted into "lock screen/unlock screen" commands. FileMaker script  
commands which fill variables and fields are converted into the LiveCode "put" command. 
All of these converted scripts will require additional development after the conversion process has 
been completed by FmPro Migrator Platinum Edition, as these conversions are primarily intended 
to reduce the amount of typing required by the LiveCode developer.

After the scripts have been created during the automated conversion process , post processing is 
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done on the scripts using the included FM Functions to LiveCode Mapping.livecode stack. More 
details on the post processing tasks is described in the Post Conversion Steps part of this 
manual.
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Importing FileMaker Database Info

This document explains the process of converting FileMaker Pro, Microsoft Access or Visual 
FoxPro projects into LiveCode projects.

FileMaker Pro 11 Notes

Issue #1: Unescaped Unicode Characters
Note: There is a documented issue with FileMaker Pro/Advanced 11 database DDR XML file 
exporting which can cause problems during the conversion process. FileMaker 11 puts 
unescaped high ASCII and Unicode characters onto the clipboard and into the DDR XML file. 
These errors can prevent the conversion process from working properly, as a valid XML file needs 
to be read for processing purposes. The copying of info to and from the clipboard may also be 
affected by this issue.

Workaround #1: If this problem affects the database file you are processing, consider switching to 
FileMaker Pro Advanced 10 for the exporting process. 

Workaround #2: If your database also contains FileMaker 11 charts, then consider manually 
copying only those layouts containing charts into FmPro Migrator via the clipboard. 
When switching between different versions of FileMaker for layout importing, select the correct 
version of FileMaker from the source database menu on the FileMaker tab of the FmPro Migrator 
main window. FmPro Migrator does handle mixed layout versions without difficulty, as the format 
version of each layout is checked during the processing, and version differences are handled 
automatically.

Issue #2: Transferring Container Field Images

FileMaker 11 introduces a new and greatly improved ODBC driver. However FileMaker 11 no 
longer supports the use of "SELECT * FROM TableName" SQL command in order to retrieve 
container field data. All previous versions of FileMaker supported the export of the JPEG preview 
version of the container field contents. FmPro Migrator provides a container field export feature 
which exports the requested data type into a file onto the disk. But this process only works 
correctly if all records contain the exact same type of data for exporting, for the selected field.

Workaround #1: Switching back to FileMaker 10 for container field data transfers to SQL database 
servers, is probably the easiest solution to this limitation. But be aware that the older ODBC 
drivers (FileMaker 7, 8, 9, 10) may exhibit a bug which can lose records when transferring data. 
Please double-check the count of records which were transferred to make sure that this problem 
has not occurred. 

Issue #3: Portal Fields
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It is more challenging to properly associate FileMaker portal fields with the portal where they are 
actually used. FmPro Migrator may assign portal fields to the wrong portal. 

Workaround #1:
If this happens, you can manually change the DataGrid Row Template assignment within the 
LiveCode IDE.

Workaround #2:
FileMaker 12+ databases using the .fmp12 file format store this information in a more easily 
readable format. If you can upgrade a file into the .fmp12 file format, it will be possible to use the 
Image Export to SQL Databases feature.

FileMaker Pro 12+ Notes

Advantage #1:

FileMaker 12+ database files store information about Portals in a more easily readable format 
within the XML definition of the layout. Using a FileMaker 12+ version file can make the 
assignment of fields more accurate during the conversion process. Otherwise, it is possible that 
FmPro Migrator could assign fields to the wrong DataGrid within the converted stack file. This is 
one advantage to converting a file from the .fp7 to the the new FileMaker .fmp12 file format. 

Pre-Migration Tasks - LiveCode Conversion

Prior to importing FileMaker, Access or Visual FoxPro database applications into FmPro Migrator, 
review the database schema and make appropriate changes:

1) The each database table must have a primary key column.
2) FmPro Migrator looks for columns having the Unique and Not Empty validation properties in 
order to automatically determine which column should be created as a Primary Key column in the 
SQL database. The PK column attributes can be changed after importing by double-clicking the 
column name displayed in the Fields List on the Tables tab of the Migration Process window.
3) The detailed instructions for data transfer to SQL databases recommends deleting Global, 
Unstored Calc and Summary fields prior to transferring the data. If these columns are deleted, 
then the generated stack will display errors about missing columns unless these columns are 
restored.
4) FileMaker databases containing repeating fields should be redesigned to eliminate the use of 
repeating fields prior to conversion into the LiveCode application. FmPro Migrator Platinum 
Edition makes this process possible during the database table migration process. Transfer the 
repeating fields data to any SQL database using FmPro Migrator Platinum Edition. Then import 
the related records back into a new table within FileMaker using an ODBC import from the SQL 
database. Create a relationship from the parent table to the newly imported repeating fields table 
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in FileMaker. Create portals on layouts to replace the original repeating fields. Then, when the 
conversion process is done, the portals will be converted into data grid objects in the stack.

A Note About Other Databases

This migration process is specifically optimized for the conversion of FileMaker Pro databases 
into LiveCode stacks. This is due to the fact that every layout and field in a FileMaker database is 
expected to be data bound to a database table or column. However, Microsoft Access and Visual 
FoxPro database applications may have fields which are populated with data via Queries or 
FoxPro scripts. 

After importing one of these other databases into FmPro Migrator, it could be beneficial to perform 
a conversion of the database into a FileMaker Pro .fp7 database file. Then work on this file to 
assign tables and fields to each field and layout so that it is functional within FileMaker Pro. Then, 
when all changes have been made to the FileMaker Pro database, import the FileMaker Pro 
database into FmPro Migrator for conversion into the LiveCode stack. If these types of changes 
are not made, it is likely that some converted cards will generate errors due to a missing table or 
field names.

Importing FileMaker Pro Database Info into FmPro Migrator

1) Download and following the instructions in the How to Import FileMaker Pro Databases into 
FmPro Migrator PDF manual from the FmPro Migrator support web page. Or, watch the videos 
linked from the FmPro Migrator support web page. Select Help from the Help menu in FmPro 
Migrator and your web browser will open this web page. It is generally a good idea to migrate the 
data into the SQL database, prior to migrating the Layouts into another development environment.

2) If you are transferring data from FileMaker Pro to a SQL database server, then download the 
appropriate manual on the support page for the destination SQL database. The Pre-Migration 
Preparation Process PDF provides another resource for migrating the data from FileMaker Pro to 
SQL database servers.

At the completion of these procedures, your data should already be migrated to the destination 
SQL database, and the Layouts, Value Lists, Scripts and Relationships should have been 
imported into FmPro Migrator.

http://www.fmpromigrator.com/support/fmpro_migrator/How_to_Import_FileMaker_Pro_Databases_into_FmPro_Migrator.pdf
http://www.fmpromigrator.com/support/fmpro_migrator/How_to_Import_FileMaker_Pro_Databases_into_FmPro_Migrator.pdf
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Importing Microsoft Access Database Info

1) Prior to performing any of the migration procedures listed below, it is recommended that you 
review the database structure of the Microsoft Access database(s) you are migrating. It is 
important to insure that each table is configured with a Primary Key column. FmPro Migrator looks 
for columns having the Unique and Not Empty validation properties in order to automatically 
determine which column should be created as a Primary Key column in the SQL database. 

2) Download and following the instructions in the How to Import Microsoft Access Databases into 
FmPro Migrator PDF manual from the FmPro Migrator support web page. Select Help from the 
Help menu in FmPro Migrator and your web browser will open this web page.

3) If you are transferring data from Microsoft Access to a SQL database server, then you will likely 
use an importing procedure to import the data from the Access .mdb/.accdb file(s) into the 
destination SQL database. [FmPro Migrator supports directly copying data to FileMaker Pro 
databases, but not into SQL database servers.]

At the completion of these procedures, your data should already be migrated into the destination 
SQL database, and the Forms/Reports, Value Lists, Scripts and Relationships should have been 
imported into FmPro Migrator.
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Importing Visual FoxPro Applications

1) Prior to performing any of the migration procedures listed below, it is recommended that you 
review the database structure of the Visual FoxPro project you are migrating. It is important to 
insure that each table is configured with a Primary Key column. FmPro Migrator looks for columns 
having the Unique and Not Empty validation properties in order to automatically determine which 
column should be created as a Primary Key column in the SQL database. Also, columns marked 
as NOT NULL should not contain NULL values, or the data transfer process will fail.

2) Download and following the instructions in the How to Import Visual FoxPro Projects into 
FmPro Migrator PDF manual from the FmPro Migrator support web page. Select Help from the 
Help menu in FmPro Migrator and your web browser will open this web page.

3) If you are transferring data from Microsoft Access to a SQL database server, then you may use 
an importing procedure to import the data from the DBF file(s) into the destination SQL database. 
Or you may use FmPro Migrator to transfer data from the DBF files into the destination SQL 
database server.

At the completion of these procedures, your data should already be migrated into the destination 
SQL database, and the Forms/Reports, Value Lists, Scripts and Relationships should have been 
imported into FmPro Migrator.
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Adding the Button Bar Widget

FmPro Migrator will add the Button Bar widget to your new stack file automatically - and it will be 
displayed during the conversion process. But this widget needs added to the LiveCode IDE 
before it will be displayed within the stack from within the LiveCode IDE. Follow these instructions 
to install the Button Bar widget.

Button Bar Widget - Unknown Module Error

If you open the newly created Application.livecode stack before installing the Button Bar widget, 
you will see the Unknown Module error dialog.
This error will not occur during the actual conversion process because the Button Bar widget is 
built into FmPro Migrator and is displayed on screen during the conversion process.

Button Bar Widget - Uninstalled Widget Outline Displayed in Browse Status Area Group

If you close the error dialog and edit the Browse Status Area/Find Status Area groups, you will see 
the Button Bar widget outline when clicking on it.
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Download Button Bar Widget - LiveCode Store Web Site

The Button Bar widget can be downloaded from the LiveCode store at 
https://livecode.com/extensions/
Download and unzip the Button Bar widget folder.

The Button Bar widget is not yet available within the store link in the Extensions Manager of the 
LiveCode IDE.

https://livecode.com/extensions/
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Download Button Bar Widget - FmPro Migrator Web Site

The Button Bar widget can be downloaded from the same web page where FmPro Migrator was 
downloaded. Download and unzip the Button Bar widget folder.

The Button Bar widget is not available within the store link within the Extensions Manager of the 
LiveCode IDE - but it is available from the LiveCode store website as a free download.
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Extension Builder Window

From within the LiveCode IDE, select the Tools -> Extension Builder menu item. (1) Click the 
folder icon in the upper right corner of the Extension Builder window, select the buttonbar.lcb file 
from the Button Bar widget folder.  (2) Click the Install button. 
Quit and re-open the LiveCode IDE so that the dictionary entries are displayed for the new widget 
you have just installed.
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Button Bar Widget - Displayed in Browse Status Area Group

Once the Button Bar widget has been installed, open the newly created Application.livecode 
LiveCode stack to see it displayed.

Button Bar Widget - Displayed in Find Status Area Group

Clicking on the Find button in the Browse Status Area group, will display the Find Status Area 
group.
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Converting to a LiveCode Stack

Step 3 - Convert Database to LiveCode

Click the LiveCode Conversion button to open the LiveCode Conversion window. 
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LiveCode Conversion Window

Some of the features available in the LiveCode Conversion window include:

(1) The Layouts Qty label displays the number of layouts which will be converted. This number 
represents the number of layouts which have been captured and stored in the FmPro Migrator 
project file.
(2) Output file types include: Application.
The horizontal Button Bar widget and status area will be added to the stack instead of the 
previously used vertical status area.
(3) Card Script Status options include: Normal, Commented.
Sometimes you may want to just convert a database and then quickly see the results without 
converting the data or building a database. Selecting the Commented option comments out the 
getData and refreshFields handlers on each card. No errors will be displayed navigating between 
cards due to there not being a database available.
(4) Processing Status - Lists the number of layouts, scripts and elapsed time for the processing.
(5) Export Template Stack button - Exports the template stack into a file named Application.rev in 
the output directory (overwrites existing copies).
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(6) Code Conversion Wokbench button - for converting scripts into LiveCode from FileMaker, 
Microsoft Access or Visual FoxPro.
(7) Migrate button - Click this button to perform the migration.

Post Conversion Development

The Post Conversion Development section of this manual provides a flowchart of the steps 
needed and LiveCode utility stacks included for use after the stack has been created.

In addition to converting the FileMaker layouts, FmPro Migrator Platinum Edition also converts 
FileMaker scripts into LiveCode scripts. These scripts will be placed into two output files will be 
written to the output directory:

FmPro Original Scripts.txt file - This is a text version of the original Script Workspace scripts, and 
is made available for documentation purposes so that LiveCode developers can review the 
original unconverted scripts.

FmPro Converted Scripts.txt - This text file contains the converted LiveCode code. Any instructions 
which could not be converted will be commented and the original comments will be retained 
within the scripts.
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Supported FileMaker Pro Layout Object Types

The following FileMaker Pro Layout object types are currently supported by the conversion 
process:

Fields
Custom Value Lists
Field Value Lists
Merge Fields
Portals
Text
Lines
Charts [LiveCode 8+]
Rectangles
Rounded Rectangles
Ovals/Circles
Grouped Objects
Images
Buttons
Popover Buttons
Tab Controls
WebViewer

Each FileMaker Pro layout object is re-created as an equivalent LiveCode card object, using the 
formatting and style attributes of the original object. 
Stylized FileMaker Pro layout text objects are converted into LiveCode text labels, having the 
embedded text styles of the original object defined with the HTMLText property.

The supported field display options include Check Box Set, Radio Button Set, Pop-Up Menu, Drop 
Down List and Calendar. Pop-Up menus and Calendar objects are created with embedded Rev 
script code to automatically populate the underlying field.

Note: The Chart object is converted into a LineGraph widget when LiveCode 8+ versions are 
selected. Some additional work will be required to populate the LineGraph widget with data, as it 
is placed onto the card as a placeholder. Since the LineGraph widget does not support all of the 
chart types supported by FileMaker, 3rd party charting tools including ChartsMaker and 
ChartsEngine may also be considered.

Unsupported FileMaker Pro Layout Object Types

The following FileMaker Pro Layout object types are not currently supported by the conversion 
process:
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Conditional Formatting - Conditional formatting can be used to automatically resize fields and 
change the appearance or color of field data based upon a calculation formula. The automated 
resizing or movement of objects can be done by using LiveCode's Geometry Manager. Within 
LiveCode, the movement of objects can even be made dependent upon the movement of other 
nearby objects, offering more control of objects than is available within FileMaker Pro.

Embedded Page#, Date, Record# Layout objects - These objects should be manually replaced 
with some other object like a text label holding the data to be displayed. Plus the addition of a little 
bit of revTalk code to display the proper Page#, Date etc. However the record# is presently 
displayed within the record number field in the status area, under the record navigation slider.

Cosmetic Changes Required  - Example #1

In general, each created object within the LiveCode stack will appear very similar to its counterpart 
in the original application. However, some changes may be required within the generated stack 
file.  This image of a converted LiveCode stack file shows 3 changes which should be made:
1) The Help button icon has been created, but the (?) image is sitting under the shadowed circle 
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object. FmPro Migrator Platinum Edition builds each layout object in the order it is found within the 
Layout XML file. Therefore some objects may be created in the wrong order for display purposes. 
The solution is to change the layer of each object so that they display properly. The shadowed 
circle object was also moved left by 1 pixel.
2) The text over the purple rectangle object is displayed a little bit too high.

Cosmetic Changes Applied - Example #1

Click on the group named "Layout_Objects_Group", click the Edit Group button in the LiveCode 
IDE to make changes to the objects on the card.
This image shows the stack after the 3 cosmetic changes were made.
1) The graphic was adjusted by sending the white circle to the back of the canvas.
2) The text label margin property was adjusted from 2 to 8 to change its position to be more 
readable.
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Original FileMaker Pro Layout

And for comparison purposes, here is an image of the original FileMaker Pro Layout.
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Cosmetic Changes Required - Example #2

Here is another converted Layout stack file which needs different cosmetic changes:
1) FmPro Migrator Platinum Edition creates each LiveCode field as an opaque field, in order to 
insure that fields having a background color are displayed properly. Text objects however, are 
created with their opaque property set to false, allowing other objects to show thru. But the 
dbMaintenanceMessage object shown on this layout is not a Text object, it is a field object, so it 
has been created to be opaque - thus hiding the text label which it overlaps. Therefore in this 
location, the dbMaintenanceMessage field should have its opaque property set to false.
2) This horizontal line is supposed to be colored green, but the correct color was not properly 
located within the original XML code. This same problem also occurs with the objects marked (4) 
and (5). However the remaining horizontal line objects on this same layout (not shown) did retain 
their correct colors.
3) These two text label buttons ended up wrapping within the field. Changing the text margin from 
2 to 4 and widening the fields solved these issues.
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Cosmetic Changes Applied - Example #2

This image shows the stack after the 5 cosmetic changes were made.
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Customizing the LiveCode Stack Conversion Process

Fmig_Preferences.xml File

FmPro Migrator utilizes an optional XML preferences file which can be used to customize the DB 
To LiveCode conversion process. This XML template file can be placed into the FmPro Migrator 
directory within the /User/Library/Preferences (or My Documents on Windows) directory to 
customize the generated stack file.

Using a Different StackTemplate File

The StackTemplate option enables LiveCode developers to extract and customize the standard 
template stack embedded within FmPro Migrator. Click on the Export Template Stack button on 
the Database to LiveCode window to extract the existing template stack file to the output directory 
(it will overwrite any existing file). You should move or rename this file and update the XML 
preferences file to point to the modified version of the file.

The custom version of your template stack file will be copied into the output directory, renamed as 
Application.rev and used as the destination stack where all of the converted layout objects will be 
created.

This means that you can add that one line command from article #3 into the showAllRecords 
handler in the card stack, and that correction along with any other changes you make will 
automatically be used as your new template stack. You might also want to change the look of the 
status area. You could create a new status area across the top of the card, to simulate the look of 
newer versions of FileMaker Pro. Or you might turn the status area into a floating palette.



LiveCode Conversion Procedure - 35

The Template Stack

FmPro Migrator Platinum Edition uses an internally-stored template file for the LiveCode stack 
which it generates from the FileMaker Pro Layouts. This file is written to the output directory as a 
file named Application.rev at the start of the conversion process . 
LiveCode developers can supply their own stack in place of the Application.rev file, in order to 
make use of their own customized handlers and graphics. FmPro Migrator Platinum Edition 
always deletes and overwrites any existing Application.rev stack file. 

A replacement template stack can be specified in the FmPro_Migrator_Preferences.xml file.

A replacement template stack should have the following features, in order to be compatible with 
FmPro Migrator Platinum Edition:

setLayoutList - stack-level handler - This handler puts the list of cards into the Layout list menus 
of the Browse and Find groups. If you don't want to have this feature, you can simply include a 
handler having this same name but containing no executable code.

displayCalendar - stack-level function - This handler displays the calendar pop-up menu within 
fields which have this feature configured within the original FileMaker Pro Layout. This function 
returns empty or the date picked by the user.

browserInit
browserGo
browserEnsure
browserFinalize
browserBack
browserForward
browserRefresh
browserStop 
These stack-level handlers control one ore more revBrowser controls on a card. Each handler 
takes a parameter (pBrowserNum) as the number representing the Browser control, and is used 
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to define its name on the card. There could be multiple FileMaker WebViewer objects on a single 
Layout, therefore each WebViewer will be converted into a separate Revolution Browser control 
having a different name on the card.

statusAreaWidth - stack-level customProperty - This custom property indicates the width of the 
Status Area at the left s ide of the window. The Layout_Objects_Group is automatically moved over 
to accommodate the width of the Status Area after all of the cards have been created. Set this 
custom property to 0 if you don't want to have a Status Area within your template stack.

templateStackName - stack-level customProperty - This custom property provides the name of 
the template stack file. 

segmented Widget - When FmPro Migrator builds a segmented widget, it copies the Segment 
Group containing a sample segmented widget from the Images card of the template stack. 
Updating the properties of this segmented widget will cause all of the newly created segmented 
widgets to have the same basic color properties for instance.
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FmPro Custom Property Set

Each card in the generated LiveCode stack file includes a custom property set named FmPro. 
This custom property set includes detailed info about the field objects which have been created 
on the card by FmPro Migrator Platinum Edition. This information is expected to be useful for 
LiveCode developers who want to create data entry/validation and data display handlers for each 
of the fields on the card. This info is also used by the handlers which clear field data upon 
entering Find mode and when filling each field with data.
Having the fields listed in a custom property set also means that developers don't have to 
manually type in each of the field object names into their code either. Just loop thru the lines of 
data in the custom property set to work with the names and data types for each field on the card.

FmPro - customPropertySet Overview

There are 4 customProperties within the FmPro customPropertySet.
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Version - customProperty

The Version customProperty defines the version of the customPropertySet schema. The current 
value for the Version customProperty is 1, this value will change as enhancements are made to 
the FmPro customPropertySet.

baseTable - customProperty

The baseTable customProperty represents the name of the base table referenced by the original 
layout.

fieldList - customProperty

The fieldsList is a TAB delimited list providing 23 parameters for each field which has been 
created on the card. These parameters are shown in the screenshot with sample values and are 
listed below:

(1) Rev Object Name - The name given to the LiveCode field when it was created.
(2) Original FileMaker Pro Field Name - This is the name of the Table Occurrence::Fieldname in 
the original FileMaker Pro database. 
(3) SQL Table Name  - The converted name of the original table, as it appears in the SQL 
database.
(4) SQL Yoga Relationship Name  - If the field is in another table, the relationship name to use to 
get the data from the table.
(5) SQL Table Column Name  - The converted name of the SQL database column name.
(6) SQL Table Column Type  - The type of data contained in the field, matching the field types for 
the destination SQL database.
(7) LiveCode Object Type  - The type of LiveCode object. Use this object type and its name when 
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referencing the object.
(8) Usage Type  - The way in which the object is used on the card, either as a field or a menu. This 
parameter indicates whether you need to put data into the field (for a field) or into the label of an 
object (for a menu).
(9) Entry Options Flag - The entry options for entry of data within a field, as defined by the fieldObj 
flags XML parameter in the original layout. Multiple options may be applied to a field 
simultaneously. To determine if a particular value is selected, use the bitAND Revolution 
instruction. See the following screenshot for more details.
(10) Currency Symbol - The symbol used for currency values.
(11) Thousands Separator Symbol - The symbol used to separate thousands, in numeric values.
(12) Decimal Point Symbol - The symbol used for decimal points in numeric values.
(13) Number of Decimal Digits - The number of values displayed to the right of the decimal point 
symbol
(14) Negative Color (RGB) - The RGB values, separated by commas which should be used for 
negative numeric values.
(15) True String - The text string used for true values.
(16) False String - The text string used for false values.
(17) Date Separator Char - The symbol used for separating short date values. (i.e. MM/DD/YYYY).
(18) Date Element Separator1 - The first date separator character string, used when displaying 
dates in long format.
(19) Date Element Separator2 - The second date separator character string, used when 
displaying dates in long format.
(20) Date Element Separator3 - The third date separator character string, used when displaying 
dates in long format.
(21) Time Separator Char - The symbol used for separating time values (i.e. HH:MM:SS)
(22) Time AM String - The suffix string used for displaying AM time values .
(23) Time PM String - The suffix string used for displaying PM time values.

Entry Options Details - (fieldObj flags values)

Multiple entry options can be applied to the same field. To decode these values, use the LiveCode 
bitAND command as follows:
put varFieldEntryOptions bitAnd 4 into tResult
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if tResult = 4 then set the lockText of field Field1_fld to true
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FileMaker Converted Script Steps

These script steps represent the FileMaker script steps which are directly converted into LiveCode 
by FmPro Migrator.

Note: Using the Code Conversion Workbench feature of the AI Accelerated Edition of FmPro 
Migrator enables the conversion of all script steps and lines of code from FileMaker Pro, Microsoft 
Access and Visual FoxPro.

List of Converted Script Steps

The following list documents the script steps which are converted from FileMaker scripts into 
LiveCode commands:

Go to Layout
Perform Script
Beep      
 #
 Copy
 Cut
 If
 End If
 Else
 Exit Application
 Exit Script      
 Freeze Window      
 Halt Script
 Open URL
 Paste      
 Perform AppleScript
 Print Setup
 Print      
 Refresh Window
 Select All
 Send Event      
 Set Error Capture
 Send Mail
 Set Field
 Set Variable       
 Show Custom Dialog
 Show/Hide Status Area
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 Enter Find Mode
 Enter Browse Mode
 Speak 
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Post Conversion Development
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Overview of Post Conversion Development - LiveCode Conversion

Overview

A converted application will generally display data in most fields and portals and provide record 
and form navigation via the Button Bar status area at the top of the window.
There will be additional steps required in order to have a fully functional application ready for 
production deployment. A summary of these tools is discussed below.

The first tool you will probably use is the JSON Connection File Builder utility. This tool makes it 
quicker and easier for you to log in the converted application into the database server without 
manually re-typing login credentials many times per day.
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JSON Connection File Builder

The JSON Connection File Builder builds a database connection JSON file named 
DBConnection.JSON. 
This JSON connection file has 2 main uses:
1) During development, you can quickly log the application under development into your test 
server without having to manually enter connection details.
2) For production usage, you can create connection files having the database type, name, port, 
hostname info pre-filled for users to log into the database server. Fields which are missing from 
the DBConnection.JSON file will be filled in by the user during login.

For more details, see the the section of this manual describing the JSON Connection File 
Builder.livecode stack.
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Process Flowchart

This flowchart provides an overview of the tools provided for the LiveCode conversion process 
and their usage during development. These tools are described in detail later in this manual.
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Conversion Process Output 
Files
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Overview of Conversion Files

Overview

This chapter of the manual describes the various output files created by FmPro Migrator when 
performing a LiveCode conversion project.
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Application.livecode

Application.livecode Overview

The main stack created by FmPro Migrator is the Application.livecode stack. All of the 
layouts/forms, Value Lists, relationships are placed into this stack during conversion. Scripts are 
also written to disk for further processing.

The utility stacks created by FmPro Migrator are available to help with further development of the 
scripts, calculations and relationships.

Regarding scripts, these should probably be added to new library stacks based upon the 
functionality of the application. For instance an application might have functionality including 
Invoices, Customers, Scheduling which could each be placed into separate library substacks.
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Corrupted Images Report.txt

Corrupted Images Report

During the conversion of layouts to LiveCode cards, some image objects might not be readable 
within the imported layout XML code. If this problem occurs, the Corrupted Images Report.txt file 
will be created in the project directory. These errors will need to be fixed manually by importing an 
image object manually into the converted stack.

In order to facilitate making manual fixes to these missing images, each line of the report 
contains:

Layout: The name of the layout where the error occurred.
Object: The object name assigned to the object by FmPro Migrator when attempting to create the 
image object.
Location: The coordinates where the new object was supposed to be created.
Error - The last part of the line is the internal LiveCode error which occurred during the import 
paint command.

The LiveCode Error Lookup stack created by Jacqueline Landman Gay can be used to look up 
the LiveCode internal errors. It is available here:
http://livecodeshare.runrev.com/stack/712/LiveCode-Error-Lookup

For the first error shown as: 263,5742,1
263 - import: can't read file, mask file or display. Not much to be added here, it just means that the 
import paint command cannot read the contents of the file being imported. FmPro Migrator 
exports images into a temporary file, then uses the import paint command to import the image 
onto the card at the specified location.

5742 - This is the line number of the script within FmPro Migrator where the import paint 
command was run. As a user, there is isn't much you can do with this info, but it could be helpful 
for .com Solutions Inc.

1 - Column number of the error.

http://livecodeshare.runrev.com/stack/712/LiveCode-Error-Lookup


LiveCode Conversion Procedure - 51

Suggestion Text - This section of the error result is empty, because the LiveCode engine doesn't 
have any suggestions to offer. In general, it is possible that the image is really corrupted or 
possibly not able to be read and converted correctly within the source XML defining the layout.
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Duplicate Objects Report.xls

Duplicate Objects Report Overview

FmPro Migrator analyzes scripts, layouts and custom functions during conversion to determine if 
any duplicates will occur in the converted application. Duplicates can occur if multiple FileMaker 
databases are combined together for conversion. A checksum is created for each of these 
objects and a comparison of the checksum and the name of the object is made in order to 
determine if the object should be skipped or renamed. 

This report is saved as a TAB delimited file having an .XLS file extension so that Excel will 
immediately open it (with a warning that it isn't really an .XLS file). 
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Missing Tables Report.xls

Missing Tables Report Overview

The Missing Tables Report lists the layouts which could not be converted because they didn't 
have a table assigned to the layout. This problem will commonly occur with placeholder layouts 
used as group separators. So in many cases, nothing needs to be done - it is just an informative 
report.

Note: Since this report is also created as a TAB delimited file designed to be read by Excel, some 
layout names might not be displayed if they start with "--" characters. Since the file is a text file, it 
can also be opened with any text editor if Excel won't read the file properly.
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create_relationships.sql

create_relationshps.sql Overview

During the conversion process, the list of relationships are read in order to create the 
create_relationships.sql file. This file should be run on the database server used by the 
application in order to create the table constraints.
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Missing Relationships Report.xls

Missing Relationships Report Overview

During the creation of each data bound field on a card, FmPro Migrator verifies that it can 
determine the base table required to read the data in the SQL database. If that test fails, the object 
is documented in the TAB delimited Missing Relationships Report.xls file.

FmPro Migrator is using the contents of the Relationships.JSON file stored as an array in memory 
in order to figure out the structure of each relationship within the new application.

If a relationship cannot be found, the findIndirectRelationships.livecode stack can be used to help 
troubleshoot the situation. Some FileMaker relationships may require being rebuilt manually to 
work with a SQL database. Manual changes made to the Relationships.JSON file need to be 
added back to the application stack as a custom property in order to be used by the application.
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Relationships.JSON

Relationships.JSON Overview

FmPro Migrator generates the Relationships.JSON file from the relationships imported from 
within the original database. Since FileMaker relationships are bi-directional, two relationships 
are created for each imported relationship to represent this same functionality. 

The contents of the Relationships.JSON file are automatically saved into the 
RelationshipsJSONProp custom property of the SQL_Library substack created by FmPro Migrator. 
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Importing the Relationships.JSON File

If the Relationships.JSON file is manually edited, it should be re-imported back into the 
SQ_Library by clicking the loadRelationshipsJSON button on the 1st card of the SQL_Library 
stack.

The Relationships.JSON data is converted into an array as soon as a successful connection is 
made to the SQL database server.

The Relationships.JSON file can be edited with the Relationships JSON Editor utility described in 
this manual.
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SQLColumnTypes.JSON

SQLColumnTypes.JSON Overview

The SQLColumTypes.JSON file is stored within the SQLColumnTypesJSONProp of the 
SQL_Library substack. 
When a database connection has been made, this JSON data is converted into the 
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gSQLColumnTypesArray. The getBLOBColumnStatus() function in the SQL_Library uses this 
array to determine whether the SQL database column contains BLOB data when reading/writing 
data in the database. 

This test is performed in order to avoid performing textEncode/textDecode on the data for BLOB 
columns.
The test is being done on the original database field type, looking for the type = "PICT" due to the 
consistency of always checking the FileMaker database type, since there are many database 
types used for various destination databases.
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Library SubStacks
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Overview of Library SubStacks

Library Substacks

The stack generated by FmPro Migrator Platinum Edition includes 8 library substacks designed to 
implement the functionality of the original database application. The metadata from the source 
database is used to generate the code placed within these substacks. The following pages of 
this manual provide details about each library substack.

Library SubStack Initialization

The openStack handler of the converted stack contains "start using stack" commands for each of 
the library substacks. These commands insure that the handlers within the subStacks can be run 
from anywhere in the application.

on openStack
   global gStatusAreaVisible,gMode
   local tError
   initializeAppPrefs
   start using stack "SQL_Library"
   start using stack "Stored_Calc_Library"
   start using stack "Unstored_Calc_Library"
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   start using stack "Value_List_Library"
   start using stack "Globals_Library"
   start using stack "fmFunctions_Library"
   start using stack "Validation_Library"
   
   if gMode is empty then
      put the result into tError
      put "Browse" into gMode
      put 1 into gStatusAreaVisible
      switchtoBrowseMode
   end if -- end of check for 1st launch
end openStack
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fmFunctions_Library

fmFunctions_Library Overview

This library duplicates the functionality of 129 of the most commonly used FileMaker built-in 
functions. A tool is provided to remap the original FileMaker functions to these LiveCode versions 
within the converted FileMaker scripts. These LiveCode function handlers are named slightly 
different from the original FileMaker functions. Therefore the included FM Functions to LiveCode 
Mapping.livecode utility stack is used to rename the functions within the converted script and 
library files. During the conversion process, the contents of the stored/unstored calc library stacks 
are written to disk as text files (Unstored_Calc_Library.livecodescript, 
Stored_Calc_Library.livecodescript). This has been done to facilitate the conversion of the 
function names from FileMaker to LiveCode.
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Globals_Library

Globals_Library Overview

The gGlobals array within the _gGlobalsInitialize handler includes FM tables/fields which are 
used as global variables. These globals are initialized during app startup to specific known 
values and can be updated anytime by the application, just like FileMaker global fields.

In a FileMaker database, these fields could be part of an existing database table, mixed with other 
non-global fields.

Within the converted stack file, these globals are located within a separate array and need 
referenced separately instead of within existing table fields which might also contain data. This 
change should be made manually within the converted scripts of the converted stack.
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Additional Preferences - LiveCode Conversion Window

Many FileMaker developers use 1 record tables containing only global fields during database 
development. FmPro Migrator provides a way to specify a global table during the conversion 
process. The fields of the selected table will be defined as a global array in the Globals_Library.

(1) Click the additional prefs button in the LiveCode Conversion window in FmPro Migrator.
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Specifying Global Fields in FmPro Migrator

Select any table in the solution - it gets added to the list of global tables as it is selected. Click to 
highlight any item and click the delete button (3) if you added a table by mistake.
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Images_Library

Images_Library Overview

The Images_Library substack provides a convenient place where commonly used images can be 
centrally stored within the new application stack. This stack contains one card named Images1, 
which can be expanded to additional cards to support more images. Buttons on other cards of the 
stack can reference the ID# of images stored in this library. Replacing an image in this substack 
with another image having the same ID# will effectively replace it everywhere within the 
application without requiring manual updates on those other cards as long as the size is the 
same.
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SQL_Library

SQL_Library Overview

The SQL_Library provides database independent code to connect to SQL database servers, 
insert, query, update, delete records, and load relationships from a JSON file.
The openDatabaseConnection handler shown here is checking for the existence of the 
DBConnection.JSON file containing database connection parameters. If found, the contents of 
this file are stored in the tDBConnectionJSONArray. When a user logs in, the contents of this array 
are overridden by any connection info manually entered by the user. This process provides the 
LiveCode developer with complete control over how much info the user needs to enter when 
connecting to the database server.
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Unstored_Calc_Library

Unstored_Calc_Library Overview

Stored field calculations are defined in this library for each table of the database from the original 
FileMaker database definition. Code which is too complex for automatic conversion is 
commented to prevent errors. This code runs as records are read from the database by the 
refreshFields handler on each card. By default, it is commented to improve performance, because 
these calcs do not necessarily need to run for every converted layout. The developer needs to 
decide whether it should run, then enable this code as needed.

This script for this library is written to disk as Unstored_Calc_Library.livecodescript in order to 
facilitate using the FM Functions to LiveCode Mapping.livecode utility to replace the FileMaker 
functions with the re-written LiveCode versions of these functions in the fmFunctions_Library.
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Stored_Calc_Library

Stored_Calc_Library Overview

The Stored_Calc_Library performs calculations for stored field calculations for each table of the 
database from the original FileMaker database definition. Code which is too complex for 
automatic conversion is commented to prevent errors. This code runs during record update/insert 
database tasks.

This script for this library is written to disk as Stored_Calc_Library.livecodescript in order to 
facilitate using the FM Functions to LiveCode Mapping.livecode utility to replace the FileMaker 
functions with the re-written LiveCode versions of these functions in the fmFunctions_Library.
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Validation_Library

Validation_Library Overview

The Validation_Library performs field validation handlers during database insert/update tasks for 
each database table of the converted database.
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Value_List_Library

Value_List_Library Overview

Custom and field based value lists are defined within the Value_List_Library. Changes made 
here are reflected throughout the entire application. Value lists from Microsoft Access and Visual 
FoxPro are also defined inside this library.
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Conversion Utilities
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JSON Connection File Builder.livecode Utility

Opening JSON Connection File Builder

When FmPro Migrator performs a conversion project, it creates the LCUtilities.zip file in the project 
folder where the converted stack is created. Extract the contents of this zip file and double-click the 
JSON_Connection_Builder.livecode stack to open it in the LiveCode IDE.

JSON Connection File Builder

The JSON Connection File Builder builds a database connection JSON file named 
DBConnection.JSON. 
This JSON connection file has 2 main uses :
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1) During development, you can quickly log the application under development into your test 
server without having to manually enter connection details.
2) For production usage, you can create connection files having the database type, name, port, 
hostname info pre-filled for users to log into the database server. Fields which are missing from 
the DBConnection.JSON file will be filled in by the user during login.

Password Encryption - JSON Connection File Builder

The JSON Connection File Builder utility encrypts the contents of the password field before writing 
the JSON file. The encryptPassword function in the stack performs this task. These two handlers 
correspond to identical handlers located in the application stack.

Note: It is recommended that you change the encryption/decryption password in both locations 
before distributing your production application.

Usage Ideas: It is likely that this JSON Connection File Builder utility will be used during 
development to simplify the login process during testing. But it is hoped that by distributing this 
stack and its source code, it could give developers ideas for turning it into a more extensive utility 
for production use. For instance, a more extensive tool could be developed by LiveCode 
developers to automate the on-boarding process for new customers. 
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Password Encryption/Decryption - Application Stack

The encryptPassword/decryptPassword handlers are located at the top-level of the 
Application.livecode stack as shown in the screenshot above.
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DBConnection.JSON File Creation

The code which creates the DBConnection.JSON file is straightforward. The contents of the fields 
are gathered into variables, encrypted (if necessary) and placed into an array. The array is 
converted into JSON text and written to disk in the location specified by the user.
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FM Functions to LiveCode Remapping.livecode Utility

Opening the FM Functions to LiveCode Remapping Utility

When FmPro Migrator performs a conversion project, it creates the LCUtilities.zip file in the project 
folder where the converted stack is created. Extract the contents of this zip file and double-click the 
FMFunctionsToLiveCodeMapping.livecode stack to open it in the LiveCode IDE.
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FM Functions to LiveCode Remapping Utility - Overview

The FMFunctionsToLiveCodeMapping.livecode stack is provided to automate the conversion of 
FileMaker Pro functions into equivalent LiveCode functions located within the fmFunctions_Library 
substack. This utility is provided as an unlocked stack so that the developer can make changes if 
necessary.
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Getting the List of FileMaker Functions

This utility already contains a list of the latest FileMaker Pro functions stored within the stack, so 
you might not need to update the list, and could skip this section.

But if you wanted to update the functions list, (1) select the FileMaker version menu which will 
populate the FileMaker URL field with the proper web page. (2) Click the Get Web Page button. 
The LiveCode browser widget (3) will display the contents of the specified URL. Once the page 
has loaded into the browser widget, a callback message will be sent to retrieve the text from the 
browser and populate the text of the functions into the (4) Web Result field.

Note: FileMaker versions 16 - 18 at this time seem to return the same list of functions. This 
appears to be due to all of the functions being available on the webpage but unneeded functions 
are omitted from being viewed if they don't apply to the selected FileMaker version. However this 
automated process retrieves all of the text of the webpage, so all functions are seen.

Building the Functions List

The contents of the Web Result field are intended to be correct, but it should be edited manually if 
necessary prior to proceeding to the next step. After any manual changes have been made to the 
Web Result field, click the Build List button.
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After clicking the Build List button, the functions will be copied from the Web Results field, sorted 
and counted when placed into the Functions List field. This will be the official list of functions 
moving forward.

Adding Exceptions to the Functions List - #1

Many FileMaker functions are very close in name and functionality to their equivalent LiveCode 
functions. The FileMaker Get() functions are remapped automatically because the LiveCode 
function names have been designed to match the same naming format. 

Changes can be made to the rest of the functions by adding exceptions to the list to name a new 
LiveCode function to replace the FileMaker function.

To make this type of addition, (6) click a function in the Functions List field. (7) Click the Add 
Exception button. A new entry will be added to the Exceptions List. (8) Click column #2 of the 
Exceptions List and type the name of the new LiveCode function. 

Adding Exceptions to the Functions List - #2

 For this example, Extend might be replaced with ExtendFM. Add a space after the Extend function 
name, (9) then type the new LiveCode function name.
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Adding Exceptions to the Functions List - #3

After typing the new LiveCode function name, (10) click the Reformat button, the new LiveCode 
function name will be moved over to column #2. 

Note; If there aren't any functions listed in the Exceptions List, click the Load button to populate 
this field with the internally stored copy of exceptions.

Loading/Saving Exceptions to the Functions List - #4

The (12) Load button is used to load the previously stored copy of the Exceptions List from the 
FunctionsExceptionsList custom property of the FM Functions to LiveCode Remapping.livecode 
stack. 

After modifying the Exceptions List, (13) click the Store button to save the results back into the 
FunctionsExceptionsList custom property.
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Deleting Exceptions to the Functions List - #5

To delete an exception, click the row of the Exceptions List, (14) then click the Delete button.

It is also possible to click the (15) Delete All button to delete all of the exceptions.

After modifying the Exceptions List, (13) click the Store button to save the results back into the 
FunctionsExceptionsList custom property.

Remapping List & Save JSON File

Now that the Exceptions List has been created, (16) click the Remap button. The Remapping List 
field will be populated with all of the function names which can be remapped to LiveCode 
functions and the qty of functions will be displayed below the Qty label.

Click the (17) Export JSON File button to save the contents  of the Remapping List field as a JSON 
file.

Click the (18) Import JSON File button to load previously saved Remapping List field contents into 
the field.
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Splitting Converted Script Files

Some of the converted scripts files can become large in size. It is easier to manage the converted 
code by splitting it into smaller more manageable pieces. To split files into smaller pieces:

(19) Click the Browse button to select a converted script file. Files with .txt and .livecodescript can 
be selected.

If the file is large in size (1MB or more), (20) click the Split Files button to split the file into smaller 
parts having about 10,000 lines of code each. Each new file will be given a name ending with: 
_Part1, _Part2 etc.

Once a file has been split, select the 1st of the pieces to continue remapping of the functions.

Analyze Scripts

It is helpful to know how many instances of a specific function exist within script files in order to 
prioritize the writing of new LiveCode replacement functions.

(21) Select a type of analysis [Detailed or Existence]. 
The Detailed analysis shows how many times a specific function was used, but it takes longer to 
run.
Selecting the Existence option just determines if a specific function has been used within a script.

(22) Click the Analyze Scripts button to perform the analysis.

(23) Click the Save Report button to save the results of the Usage Report to a text file.
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Remap & Save

(24) Click the Remap & Save button to remap the FileMaker functions into LiveCode functions. 
The resulting file will be automatically saved using the original filename plus the text 
"_Remapped" as the new filename.

The resulting text file is now ready for development within LiveCode. As part of the development 
process, it will be a good idea to plan exactly where you want the new scripts to be stored within 
the converted LiveCode application stack.
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Relationships JSON Editor

When performing an automated LiveCode conversion project, FmPro Migrator generates the 
Relationships.JSON file from the relationships imported from within the original database. This 
file is saved to disk and is also imported into the RelationshipsJSONProp custom property of the 
SQL_Library substack created by FmPro Migrator.

The Relationship JSON Editor utility serves as a graphical tool for editing and saving the 
relationships JSON data as the LiveCode app continues to be updated.

Downloading the Relationships JSON Editor

The Relationships JSON Editor is available on the same web page where the fully functional 
FmPro Migrator was downloaded (not the Trial version).  This URL is provided with your email 
purchase receipt.
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Relationships JSON Editor Overview

The starting point for using the Relationships JSON Editor is the button bar near the top of the 
window.
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Importing the Relationships.JSON File

Click (1) the Import button to import the Relationships.JSON file.

Note: No data validation is performed when reading the JSON file. If the a random file is imported 
by accident, no data will be displayed in the Relationships data grid on the left side, but rows of 
empty data will be displayed.
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Import Results

Once the Relationships.JSON file has been imported, the names of each relationship will be 
shown in the Relationships data grid on the left side.
The count of relationships is displayed at the top of the grid.
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Saving the Relationships.JSON File

Click the (2) Save button to save the relationships (including predicates) if editing has been done. 
All editing occurs in memory, and the data only gets saved by clicking the save button and 
entering a filename. Since the file is a text file, it can be copied to change management systems 
as needed. 

After the Relationships.JSON file has been updated, it should be re-imported back into the 
SQ_Library by clicking the loadRelationshipsJSON button on the 1st card of the SQL_Library 
stack.



LiveCode Conversion Procedure - 91

Add New Relationship

Click the (3) Add button to add a new relationship, (4) enter the new relationship name in the 
dialog box then (5) click the Ok button. The new relationship with 0 predicates will be added to the 
list of relationships.
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Searching Relationship Names

To search thru the relationship names, enter search text (6) within the search field, (7) click the 
Search button or (8) click the search type radio buttons. The search will be performed and only the 
matching records will be displayed in the Relationships grid.

To perform a search, any of the following actions will start the search:
1] Type search text in the search field, then tab out of the field or click the background.
2] Click the Search button.
3] Click on any of the search type buttons Begins, Contains, Ends above the search field.

(8) The search type radio buttons perform the search as follows:
Begins: Searches the relationship names and matches the ones which begin with the search text.
Contains: Searches the relationship names and matches the ones which contain the search text.
Ends: Searches the relationship names and matches the ones which end with the search text.

During testing, even JSON files having over 1000 relationships return results in less than 1 
second on modern machines.
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Search Results

Searching for relationships displays a search results label showing the number of found records, 
followed by the total number of relationships being searched.
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Show All - Search Results

Clicking the (9) Show All button results in the display of all relationships.
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Editing Relationship Information

Clicking (10) any row of the list of relationships grid will display detailed info for the relationship 
(11), along with a list of predicates (12) for that relationship in the Relationship Predicates grid on 
the right.

Editing Relationship Information - Relationship Details

The contents of the relationship details fields are used directly by the generated LiveCode 
application to run queries on related tables, either for single row data or multiple rows of data to 
fill data grids in a manner similar to the original portal on a form/layout. The info displayed in 
these fields has been generated automatically by FmPro Migrator from the original database. 
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Manual changes to the predicates will require equivalent changes to these fields.

These fields include:
PlaceholderFieldsCSV - A CSV list of placeholder field names values is used to query the 
columns of the SQL database.

PlaceholderTablesCSV - A CSV list of placeholder table names is used when querying the related 
table(s) in the SQL database.

SQLCodeLC - This is the SQL code executed by LiveCode, where placeholder fields have been 
replaced with placeholders (:1, :2 etc) passed into the query hander.

FMRelationship - This is a SQL representation of the original query as it might appear in a 
FileMaker database, using the original table occurrence names.

SQLCode - The FileMaker table occurrence names have been replaced with the underlying SQL 
database table in the database server.

Editing Relationship Predicates

Click on any field (13) in the Relationship Predicates grid to edit its field contents. Changes are 
saved into memory automatically, but saving to disk only occurs when clicking the top-level Save 
button.
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Adding a Relationship Predicate

Click (14) the Add button above the Relationship Predicates grid to add a new empty predicate 
record. The record will be created immediately and added to the grid. Click in each of the fields to 
edit the info for the relationship.

Note: After adding the predicate, you must manually make the same changes to the top-level 
relationship fields above the Relationship Predicate grid.
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Deleting a Relationship Predicate

Click the (15) trash can icon at the right side of the record to delete an individual relationship 
predicate.
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SQL Column Types JSON Editor

When performing an automated LiveCode conversion project, FmPro Migrator generates the 
SQLColumnTypes.JSON file from the tables/fields imported from within the original database. 
This file is saved to disk and is also imported into the SQLColumnTypesJSONProp custom 
property of the SQL_Library substack created by FmPro Migrator.

When a database connection has been made, this JSON data is converted into the 
gSQLColumnTypesArray. The getBLOBColumnStatus() function in the SQL_Library uses this 
array to determine whether the SQL database column contains BLOB data when reading/writing 
data in the database. 

This test is performed in order to avoid performing textEncode/textDecode on the data for BLOB 
columns.
The test is being done on the original database field type, looking for the type = "PICT" due to the 
consistency of always checking the FileMaker database type, since there are many database 
types used for various destination databases.

The SQL Column Types JSON Editor utility serves as a graphical tool for editing and saving the 
SQL Column Types JSON data as the LiveCode app continues to be updated.

Downloading the SQL Column Types JSON Editor

The SQL Column Types JSON Editor is available on the same web page where FmPro Migrator 
was downloaded (not the Trial version).  This URL is provided with your email purchase receipt.
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SQL Column Types JSON Editor Overview

The starting point for using the SQL Column Types JSON Editor is the button bar near the top of 
the window.
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Importing the SQLColumnTypes.JSON File

Click (1) the Import button to import the SQLColumnTypes.JSON file.

Note: No data validation is performed when reading the JSON file. If the a random file is imported 
by accident, no data will be displayed in the Tables data grid on the left side, but rows of empty 
data will be displayed.
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Import Results

Once the SQLColumnTypes.JSON file has been imported, the names of each table will be shown 
in the Tables data grid on the left side.
The count of tables is displayed above the top of the grid.
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Saving the Relationships.JSON File

Click the (2) Save button to save the tables (including column info) if editing has been done. All 
editing occurs in memory, and the data only gets saved by clicking the save button and entering a 
filename. Since the file is a text file, it can be copied to change management systems as needed. 

After the SQLColumnTypes.JSON file has been updated, it should be re-imported back into the 
SQ_Library by clicking the loadSQLColumnsJSON button on the 1st card of the SQL_Library stack.
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Add New Table

Click the (3) Add button to add a new table, (4) enter the new table name in the dialog box then (5) 
click the Ok button. The new table with 0 columns will be added to the list of tables.

Note: Table names cannot be edited here, because the table name is effectively serving as a 
primary key for the data. It is possible to add and delete table names, then add columns 
individually. 
Alternatively, it would be possible to edit the table name within the SQLColumnTypes.JSON 
before importing. The same change would need to be made within the SQL database being used 
to store the data.
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Searching Table Names

To search thru the table names, enter search text (6) within the search field, (7) click the Search 
button or (8) click the search type radio buttons. The search will be performed and only the 
matching records will be displayed in the Tables grid.

To perform a search, any of the following actions will start the search:
1] Type search text in the search field, then tab out of the field or click the background.
2] Click the Search button.
3] Click on any of the search type buttons Begins, Contains , Ends above the search field.

(8) The search type radio buttons perform the search as follows:
Begins: Searches the table names and matches the ones which begin with the search text.
Contains: Searches the table names and matches the ones which contain the search text.
Ends: Searches the table names and matches the ones which end with the search text.

During testing, even JSON files having over 1000 items return results in less than 1 second on 
modern machines.
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Search Results

Searching for tables displays a search results label showing the number of found records, 
followed by the total number of tables being searched.
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Show All - Search Results

Clicking the (9) Show All button results in the display of all tables.
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Editing Table Column Information

Clicking (10) any row of the list of tables grid will display detailed about for the columns in the 
table (11),  in the Columns  grid on the right.

Editing Table Column Info

Click on any field (12) in the Columns grid to edit its field contents. Changes are saved into 
memory automatically, but saving to disk only occurs when clicking the top-level Save button.
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Note: The Column Name effectively serves as the primary key for the columns info, so the name 
of a column cannot be edited. If this type of change needs to be made, add a new column with a 
new name and delete the original one.

Adding a Column

Click (13) the Add button above the Columns grid (14) enter a name, then (15) click the Ok button 
to add a new column record having default values. The record will be created immediately and 
added to the grid.
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New Table Column

Click in each of the fields to edit the info for the column.

Note: As shown in this screenshot, when dealing with images, the OriginalColumnType field 
should contain the text "PICT", which usually translates to the "BLOB"  column type for a SQL 
database. The code in the SQL Library is only looking at the OriginalColumnType text of "PICT" to 
determine whether a database column contains binary data.
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Deleting a Table Column

Click the (16) trash can icon at the right side of the record to delete an individual table column.
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Using the Converted 
Application
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Export Records

File -> Export Records... Menu

The Export Records... menu item in the File menu exports records from the current card and 
database table as TAB delimited data into a file having an .XLS extension. The file will then be 
opened automatically in Excel after it has been saved.

Data will be exported from database columns for the table associated with the layout/form - not 
related tables. BLOB columns aren't supported for data import/export purposes.

Excel Warning Message

Excel warns that the file is not really a spreadsheet file, but it knows how to open it due to the 
contents consisting of .TAB delimited data. Just click the Yes button to open the file. Then the file 
should be saved using the latest Excel file format (i.e. .xlsx) for instance.
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Exported UTF Characters

Exported data containing UTF-8 characters requires a slightly different opening process in order 
for Excel to properly recognize the file encoding. By default, Excel imports data using the native 
character set of the operating system, which causes UTF-8 characters to be improperly read.
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Importing UTF-8 Character Data

Select Open from the File menu within Excel to open the file, then select (1) the UTF-8 encoding 
from the File origin menu.
As soon as UTF-8 is selected from the menu, the Preview field will show that the data has been 
decoded properly, so you can click the (2) Finish button.
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Import Records

File -> Import Records... Menu

The Import Records... menu imports TAB delimited text files having the .TAB or .TXT file extension.
The column names are checked to make sure they they match the fields converted from the 
original database. To see the format, perform a file export first, in order to verify the order of the 
columns.

Primary key columns are skipped on import, since these are already configured for auto-enter 
incrementing to the next higher serial number for each new record.

Data will be imported into database columns for the table associated with the layout/form - not 
related tables. BLOB columns aren't supported for data import/export purposes.
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Duplicated Column Names Error

A source database file may contain multiple copies of the same field on a layout or form. This 
situation will prevent importing of records because the columns have been duplicated.
For data import purposes, it is recommended that layouts/forms should be designed with only 
one copy of the fields needing to be imported. 
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Printing

The LiveCode stack created by FmPro Migrator includes Page Setup and Printing to printer and 
PDF output options.
These menu options are used to print from any of the cards of the stack which have been created 
by FmPro Migrator, except the Login card (since the login card contains no data or database 
fields).

Page Setup Menu

The Page Setup.. menu displays the standard Page Setup dialog provided by the operating 
system.

Page Setup Dialog - macOS

From within the Page Setup dialog, the name of the printer, paper size, paper orientation and print 
scale can be set.
The selected page setup info is stored within the application preferences JSON file and is used 
during printing.
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Note: Cards in the converted stack which are too large to fit on a singe page should be scaled 
using the Scale percentage field of the Page Setup dialog. The page scale factor is utilized for 
printer output and also for PDF output. The page setup settings are read and used to set the 
scaling during PDF output to match the printer output.

Page Setup - Windows

From within the Page Setup dialog, the name of the printer, paper size, paper orientation and print 
scale can be set.
The selected page setup info is stored within the application preferences JSON file and is used 
during printing.

Note: Cards in the converted stack which are too large to fit on a singe page cannot be scaled on 
Windows. On Windows, it is best to either select a larger paper size or reduce the amount of info 
on the card so that it will fit.

Idea: Inside the stack level printMenuPrintPages handler the printScale factor could be updated 
programmatically to specify a print scale factor. This could be set via the Print dialog by adding a 
new field for Print Scale and passing this value thru to the printMenuPrintPages handler via the 
gAppPrefsArray.
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Print Dialog

The modal PrintDialog substack is used to print cards of the converted stack file. This dialog is 
the same on macOS and Windows.

When clicking the Print button, the results are stored within the gAppPrefsArray and read from this 
global array by the printMenuPrintPages handler.

Supported features include:
Printing the current record.
Printing the records being browsed (including support for found-sets).
Printing a blank record.

Each of these output options can be printed to a PDF file or directly to the selected printer.
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